Chapter 2

Working with Projects
and Drawings

Learning Objectives

After completing this chapter, you will be able to:
* Create new projects and drawings

* Edit the properties of projects and drawings

* Add drawing descriptions

* Open existing projects

* Activate and close projects

* Add existing and new drawings to the current project
* Group the drawings of a project

* Rename, replace, and remove drawings from projects
* Assign a description to a drawing

* Open project drawings

 Copy existing projects

* Understand the working of the Project Manager
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INTRODUCTION

AutoCAD Electrical is a project-based software in which wiring diagrams related to each other
are grouped under a project. A project is a set of electrical wiring diagrams that form a project
file <project_name>.wdp. Each project is defined by an ASCII text file with .wdp extension. These
project files contain a list of project information such as project settings, project or drawing
properties, names and descriptions of drawing files, symbol library paths, and so on. You can
have an unlimited number of projects. However, only one project can be active at a time. The
list of these projects is displayed in the Project Manager.

PROJECT MANAGER

Ribbon: Project > Project Tools > Manager

Toolbar: ACE:Main Electrical 2 > Project Manager
or ACE:Project > Project Manager

Menu: Projects > Project > Project Manager

Command: AEPROJECT

EI The Project Manager is used to create new projects, open existing projects, add new

drawings to a project, re-order drawing files, access existing projects, and modify existing

information in a project. By default, the Project Manager is displayed and docked on

the left of the screen, as shown in Figure 2-1. If the Project Manager is not displayed by default,

choose the Manager tool from the Project Tools panel of the Project tab; the Project Manager
will be displayed.
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Figure 2-1 AutoCAD Electrical screen with the Project Manager

Alternatively, choose the Project Manager tool from the ACE:Main Electrical 2 toolbar to
display the Project Manager. The Project Manager is similar to other AutoCAD Electrical tool
palettes. You can dock the Project Manager at a specific location on the screen. Also, if you do
not want to use the project tools, you can hide the Project Manager.
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In AutoCAD Electrical 2017, the Project Manager is divided into two tabs: Projects and
Location View. The options in both these tabs are discussed in detail in this chapter.

Projects TAB

In the Project Manager, the Projects tab remains chosen by default, refer to Figure 2-1. When
you double-click on the title bar of the Project Manager, it gets undocked and is displayed
separately on the screen, as shown in Figure 2-2. When you right-click on the title bar of the
undocked Project Manager, a shortcut menu is displayed, as shown in Figure 2-3. You can
change the appearance, location, and display settings of the Project Manager by choosing the
respective options from the shortcut menu.
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Figure 2-2 The undocked Project Figure 2-3 The shortcut menu displayed by
Manager right-clicking on the title bar of the Project
Manager

When you double-click on a project name in the Projects rollout, a list of drawings associated
with the project will be displayed. Also, the details of the selected project will be displayed in the
Details rollout of the Project Manager, as shown in Figure 2-4. The name of the active project
will appear in bold text in the Projects rollout of the Project Manager.

When you right-click on a drawing name, a shortcut menu will be displayed. You can use the
options in this shortcut menu to open, close, copy, remove, replace, rename, or access other
editing options to modify the drawing file. These options are discussed in detail later in the
chapter. You can open a drawing file by double-clicking on it and the corresponding drawing
file name will appear in bold text in the Projects rollout of the Project Manager.
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Note
You cannot create two projects with the same name in the Project Manager. Moreover by using
the Project Manager, you can switch to different projects and change their settings.

Opening a Project < -
You can open an existing project by using the Open W BEHES S EES -O®
Project button from the Project Manager. On doing | |NFPADEMO M-
so, the Select Project File dialog box will be (s s -8

displayed. Next, select the existing project from this dialog &t NFPADEMO

7] SCHEMATIC

box and choose the Open button; the selected project’s
£ PAMNEL

name will be automatically displayed in the Projects rollout

. e X k =l EXTRA LIBRARY DEMO 2

in bold text and it will become an active project. ; POINT2POINT =
e WDDEMO 8

Creating a New Project Details BE | |-
Status: Accessibl -

Command: ACENEWPROJECT File Nme: NFPAdemowdp |

2, You can create a new project by choosing the New Location: C:\Users\CADCIM
. . : “Documents\AcadE 2017\ AeData |
= Project button from the Pr?Ject Manager. On domg & | | \proj\NFPAdemo =
so, the Create New Project dialog box will be E: _
displayed, as shown in Figure 2-5. Alternatively, use the % féi;%ﬂﬁ;:ﬁtg:\\#;::mg
ACENEWPROJECT command to create a new project. G ;;;SEE\\AUTEAD Elestrical
. . . . . = d rt

Different options in the Create New Project dialog box are g \NFPADEMST,:‘,; etz

discussed next. B =

Name Figure 2-4 The Project Manager

The Name edit box is used to enter a name for the project. displaying the Details rollout

On doing so, the .wdp extension will be automatically added
to the file name and displayed under the Create Folder with Project Name check box.

Location

The Location edit box is used to specify the location for saving the project. You can also choose
the Browse button on the right of the Location edit box to specify the location for saving
the project file (wdp file). By default, C:\Users\User Name\Documents\AcadE 2017\AeData\proj| is
displayed in the Location edit box, refer to Figure 2-5.

Create Folder with Project Name

The Create Folder with Project Name check box is selected by default in this dialog box. As a
result, a folder with a name identical to the project name will be created. Also, the new project
will be saved in that folder. The path of the folder will be the same as that defined in the Location
edit box. If you clear the Create Folder with Project Name check box, a separate folder will not
be created for the project.

Copy Settings from Project File

You can also copy the settings from an existing project and apply it to a new project. To copy
the settings from the existing project file, specify the name and location of the existing project
file in the Copy Settings from Project File edit box. Alternatively, choose the Browse button on
the right of this edit box; the Select Project File dialog box will be displayed. Select an existing
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project file and then choose the Open button; the settings of the specified project will be applied
to the new project and the location of the specified project will be displayed in the Copy Settings
from Project File edit box. By default, C:\Users\User Name\Documents\AcadE 2017\AeData\proj)
NFPAdemo\NFPAdemo.wdp is displayed in the Copy Settings from Project File edit box.

Create Mew Project @
Name:
Location:
C:\Users\CADCIM\DocumentsAcadE 2017 \AeData'\proj®

[¥] Create Folder with Project Name
CAUsers\CADCIM \Documents"AcadE 2017 AeData proj',

Copy Settings from Project File:

C:\Users\CADCIM\DocumentsAcadE 2017 Az Data'proj* NFP Ademo* NFF Ademo.wdp
OK - Propees... oK [ Cancel | [ hHep |

Figure 2-5 The Create New Project dialog box

Descriptions

The Descriptions button is used to add a description to the project. Choose the Descriptions button;
the Project Description dialog box will be displayed, as shown in Figure 2-6. In this dialog box,
you can enter a description of the new project up to 12 lines per page. If you want to add more
than 12 descriptions, click on the > button at the bottom of this dialog box. To include the
description in the reports, select the in reports check box on the right of each description line.
Note that the descriptions thus added will be included in the report headers of the report file
and the title blocks of the drawing. Now, choose the OK button from this dialog box to save
the changes made and exit the dialog box. The concept of report generation, title blocks, and
Project Description dialog box is discussed in detail in the later chapters.

OK

The OK button of the Create New Project dialog box will be activated only if you enter the
name of the project in the Name edit box. Choose the OK button; the project that you created
will be added to the current project lists in the Project Manager. Also, it will become an active
project and its name will appear in bold text in the Project Manager.

OK-Properties

The OK-Properties button will be activated only if you enter the project name in the Name
edit box. Choose the OK-Properties button; a new project will be created and the Project
Properties dialog box will be displayed. This dialog box is used to modify project settings,
components, wire numbering, cross-references, styles, and drawing formats. All information
defined in the Project Properties dialog box are saved to the project definition file (.wdp) as
project and drawing defaults. Next, choose the OK button from this dialog box to exit from it.
The options in the Project Properties dialog box are discussed later.
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Figure 2-6 The Project Description dialog box

Note

You can also create a new project by right-clicking inside the Projects rollout and then choosing
the New Project option from the shortcut menu displayed or by selecting the New Project option
from the Project selection drop-down list in the Project Manager. You will learn more about it
later in this chapter.

Working with Drawings

In the previous topic, you learned to create new projects using the Project Manager. Now, you
will learn to create new drawings within an active project.

You can add any number of drawings to your project at any time. A project file can have
drawings located in different directories. But, it is recommended that you save your drawings
and project file (.wdp) in the same folder. When you create a new drawing, an invisible smart
block, WD_M, will automatically be added to your drawing at location 0,0. The WD_M block
defines drawing settings. These settings may be different from the project settings. Thus, you can
have different settings for difterent drawings in a single project. Also, each AutoCAD Electrical
drawing should contain only one copy of invisible WD_M block. If multiple WD_M blocks are
present in the drawing, the settings may not be stored and read consistently. Also, note that the
drawing to be created will automatically get added to the active project.

Creating a New Drawing
Command:  ACENEWDRAWING

The New Drawing button is used to create a new drawing file. To do so, choose the New
Drawing button from the Project Manager; the Create New Drawing dialog box will be
displayed, as shown in Figure 2-7.
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Create NMew Drawing @

Drawing File
Name:

[ For Reference Only

Location: C:\Users\CADCIM\Documents'AcadE 2017 AeData\proj\NFF Ademo
CUzers\CADCIM \Documents AcadE 201 T AeDataproj*NFP Ademo

Description 1: -
Description 2: -
Description 3: -

|EC - Style Designators
Project Code:

Installation Code:

[ Drawing... ] [ Project... ]

Location Code:

[ Drawing... ] [ Project... ]

Sheet Values
Sheet: Section: -

Drawing: Sub-Section: -

OK - Properties. . 0K [ canced | [ Heb |

Figure 2-7 The Create New Drawing dialog box

Alternatively, invoke this dialog box by using the ACENEWDRAWING command or by
right-clicking on the Projects rollout of the Project Manager and then choosing the New
Drawing option from the shortcut menu displayed. The different areas and options in this
dialog box are discussed next.

Drawing File Area

The options in the Drawing File area are used to specify the name of a drawing file, the
template file to be used in the drawing, the location to save the drawing, and the description
for the new drawing file. The options in this area are discussed next.

Name: Enter a name for the new drawing in the Name edit box; the .dwg extension will
automatically be added to the drawing name. Note that the OK and OK - Properties buttons
will be activated only after entering the name of the new drawing in this edit box.

Template: This edit box is used to specify the path and name of a template drawing (.dwt)
for creating drawing file. Alternatively, you can choose the Browse button; the Select
template dialog box will be displayed. Select the template drawing from this dialog box
and choose the Open button; the location of the template drawing will be displayed in the
Template edit box.
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/ Note
@ After specifying the template in the Template edit box, next time when you create a new drawing,

the template entered previously will automatically get displayed in the Template edit box. If this
edit box is left blank, AutoCAD Electrical will use the default acad.dwt file.

For Reference Only: The reference drawings are used for coversheets, terminal plans,
and other non-electrical layouts in a project. These drawings save the processing time of
AutoCAD Electrical functions. To create a reference drawing, you need to select the For
Reference Only check box. On doing so, the reference drawing will be included in the
project-wide plotting and title block update operations. All other electrical smart functions
such as cross-referencing, automatic tagging, reporting, and so on will be non-functional.
By default, the For Reference Only check box is cleared.

Note
The color of the reference drawing icon displayed on the left of the drawing name in the
Project Manager is gray.

Location: The Location edit box is used to specify the location of a new drawing. The
directory of the active project file is specified by default in the Location edit box. Alternatively,
choose the Browse button on its right to specify different location for the new drawing. If you
leave the Location edit box blank, the drawing file will be created at the same location as that
of the active project. Note that you cannot create duplicate drawings at the same location.

Description 1-3: The Description 1, Description 2, and Description 3 edit boxes are used
to enter description for a drawing. In these edit boxes, you can enter up to 3 description lines
for a drawing file. You can also specify the description for a drawing by selecting it from the
description drop-down lists. But this is possible only if you have entered description in the
earlier drawings. The description thus entered will be displayed in the title block updates
and custom drawing properties.

OK

The OK button will be activated only if you enter a drawing file name in the Name edit box.
When you choose the OK button, the new drawing gets automatically added at the bottom
of the list in the active project and it appears in bold text. To view the drawing file, expand
the active project by double-clicking on the project name.

OK - Properties

The OK - Properties button will be activated only if you enter a drawing name in the Name
edit box of the Drawing File area. Choose the OK - Properties button; a drawing file will
be created at the specified location and also the Drawing Properties dialog box will be
displayed, as shown in Figure 2-8.

This dialog box is used to define settings and options for a drawing. The options in the
Drawing Properties dialog box will be discussed in the later chapters. The changes that
you make using this dialog box will be saved as attribute values on the drawing’s invisible
WD_M block. Choose the OK button from the Drawing Properties dialog box; the drawing
will be created and will appear in bold text at the bottom of the project list of the active
project in the Project Manager.
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Drawing Properties @
Drawing Settings | Components I Wire Numbers I Cross-References | Styles | Drawing Format
Drawing:  C\Users\CADCIM"\Documents'AcadE 2017 AeData'proj \NFF Ademoab dwg

Drawing File

Project: NFPADEMO

Description 1: | - Picks>
Description 2: -
Description 3: -

[] For Reference Only

|EC - Style Designators

Project Code:
Installation Code:
| Drawing... | [ Project.. |
Location Code:
| Drawing... | [ Project.. |
Sheet Values
Sheet: Section: -
Drawing: Sub-Section: -
[ ok || canesl |[ Heb

Figure 2-8 The Drawing Properties dialog box

Note

Mentioning information in the Description edit boxes, the IEC-Style Designators area, the
Sheet values area, as well as choosing the OK - Properties button is optional. You can also edit
any of these fields later in the Drawing Properties dialog box.

Tip

The IEC style designators are widely used when you are using the IEC drafting standard.
You must be aware of the drafting standards used in AutoCAD Electrical. The software
has been designed to use seven International Drafting Standards which are listed below:

1. Joint Industrial Council ---- JICI1/JIC125 (USA)

2. International Electrotechnical Commussion ---- IEC2/IEC 60617 (Europe, UK)
3. Japanese International Standard ---- J1S2 (Japan)

4. Guobiao Standard ---- GB2 (Chinese)

5. Australian Standard ---- AS2 (Australia)

6. Institute of Electrical and Electronics Engineers Standard ---- IEEE 315/315A
7. National Fire Protection Association Standard ---- NFPA (USA)
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Adding a New Drawing to the Inactive Project

You can add a new drawing to the inactive project using the Project Manager. If the
Project Manager is not displayed by default on your screen, then choose the Manager tool
from the Project Tools panel of the Project tab or choose the Project Manager tool from
the ACE: Main Electrical 2 or ACE:Project toolbar; the Project Manager will be displayed
on the left of the screen, refer to Figure 2-1. Next, choose the New Drawing button from the
Project Manager; the Create New Drawing dialog box will be displayed. Enter the required
information in this dialog box, as explained earlier and then choose the OK button; a new drawing
will be created. Also, this drawing will be automatically added to the active project and will ap-
pear in bold text at the end of the Project Drawing list. Next, to add this drawing to an inactive
project, right-click on the inactive project name and choose the Add Active Drawing option
from the shortcut menu displayed; the Apply Project Defaults to Drawing Settings message
box will be displayed, as shown in Figure 2-9.

Apply Project Defaults to Drawing Settings IEI

Do you want to apply the Project Default Values to the Drawing Settings?

e [ % [ o]

Figure 2-9 The Apply Project Defaults to Drawing Settings message box

Choose the Yes button from the Apply Project Defaults to Drawing Settings message box; the
default values of the project will be added to the WD_M block definition of the newly added
drawing. If you choose the No button, the new drawing will retain its existing settings. Choose
the Cancel button to exit the command.

Note
You can have a single drawing in multiple projects.

Adding Existing Drawings to the Current Project

You can also add the existing drawings to the current project. To do so, right-click on the project
name in the Projects rollout of the Project Manager; a shortcut menu will be displayed, as shown
in Figure 2-10. Choose the Add Drawings option from the shortcut menu; the Select Files to
Add dialog box will be displayed, as shown in Figure 2-11. Select the drawings to be added to
the project from this dialog box. Choose the Add button; the Apply Project Defaults to Draw-
ing Settings message box will be displayed, refer to Figure 2-9.

If you choose the Yes button, the default values of the project will be added to the WD_M block
definition of the newly added drawing. But if you choose the No button, the new drawing will
retain its existing settings. Also, the selected drawings will be added to your project and will
appear at the end of the Project Drawing list.

Note
You can select multiple drawing files at a time from the Select Files to Add dialog box by pressing
the SHIFT or CTRL key.
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Working with Project Drawings X[ '
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to Figure 2-8. In this dialog box, the Drawing Exception List...

Settings tab is chosen by default. Enter the Properties...
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drawing in the Sheet Values area and choose the
OK button; the section and sub-section codes
will get assigned to the drawing file. Similarly,

you can repeat the same procedure for each drawing that you want to group together, but

Figure 2-10 The shortcut menu
displayed by right-clicking on the active

project name in the Project Manager

ensure that the same section and sub-section codes are assigned to all of them.

Grouping Drawings Using Subfolders

You can create subfolders within a project to organize the drawings. To create a subfolder,
right-click on the project; a shortcut menu will be displayed. Choose Add Subfolder from
it; a subfolder with the name NEW FOLDER will be created at the bottom of the drawing
list. Rename it with a suitable name. Now, you can drag and drop the drawings available
in the project into the subfolder. When you right-click on the subfolder; a shortcut menu
will be displayed. The options in the shortcut menu are used to create and add drawings,
rename the subfolder, and so on. You can add any number of subfolders in a project. Also,
you can add subfolders within a subfolder.

You can also remove all the subfolders from an active project. To do so, right-click on an
active project and choose Flatten Structure from the shortcut menu displayed; the Flatten
Project Structure message box will be displayed warning you that if the process of flattening

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-12 AutoCAD Electrical 2017 for Electrical Control Designers

is continued, you will not be able to revert back the changes again. Note that when you use
this option only subfolders are removed and the drawings are retained in the project.

A Select Files to Add (=

Look in: ’ . NipaDemo v] & E} @ b 4 E:'_ Views + Tools

-

) Name Preview
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File name: v
SN = JCe=)

Figure 2-11 The Select Files to Add dialog box

After creating a group of drawings and subfolders, the project-wide tagging, cross-referencing,
and reporting functions can be performed on the whole project or a part of the drawing
set, using the section, sub-section coding, and subfolders.

Changing the Order of Drawings in a Project

In the Project Drawing list, the drawings created are arranged in the same sequence as they are
processed by AutoCAD Electrical during the project-wide tagging and cross-referencing operations.
However, you can change the order of the drawings present in a project by dragging and droppmg
the drawings at the required place in a sequence. You can also reorder the drawings by movmg
them between two subfolders of a project. Note that you cannot reorder the drawings by moving
them between two projects. You can press the CTRL or SHIFT key to select multiple drawings.

You can also sort the drawings in a project to change their order. To do so, right-click on the
project name and choose the Sort option from the shortcut menu displayed. If the project
contains subfolder(s), the Sort Options message box will be displayed showing four different
combinations of options to sort the drawings in the project folder and its subfolder(s), refer to
Figure 2-12. Choose one of these options as per your requirement; the Sort dialog box will be
displayed, as shown in Figure 2-13.

You can sort out the drawings in different ways depending upon the options selected from the
Sort dialog box. You can select the required option from the Primary sort, Secondary sort,
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Third sort, and Fourth sort drop-down lists. These drop-down lists include REF (reference
status), SEC (section code), SUBSEC (sub-section), and FILEPATHANDNAME (file path and
name) options.

Some projects do not contain subfolder(s). If you right-click on such a project and choose the
Sort option from the shortcut menu displayed; the Sort dialog box will be displayed, refer to
Figure 2-13.

Sort Options @
.:ﬁ:. How would you like to handle the subfolders?

There are several different combinations of options to choose from when dealing with subfolders
during a sort:

<+ Move folders to top, sort files in this folder only
< Move folders to top, sort files in this folder and subfolders
< Move folders to bottom, sort files in this folder only

< Move folders to bottom, sort files in this folder and subfolders

[T Always perform my current choice

Figure 2-12 The Sort Options message box

Sort [l

Primary sort Secondary sott Third sort Fourth sort

REF -] [sEc -] [suBsec -] [FILEPATHANDNAME |

Figure 2-13 The Sort dialog box

After setting the required parameters, choose the OK button from the Sort dialog box; the dialog
box is closed and the drawing displayed in the list will be arranged according to the options
selected from the drop-down lists.

Removing a Drawing from a Project
You can remove a drawing from a project using two methods. These methods are discussed next.

First Method

Right-click on the drawing name in the Project Manager; a shortcut menu will be displayed.
Choose the Remove option from the shortcut menu; the Project Manager - Remove Files
message box will be displayed. Choose the Yes button from the message box; the drawing
will be removed from the project, but it will not be deleted from the folder where it is stored.

Second Method

Right-click on a project name; a shortcut menu will be displayed. Next, choose the Remove
Drawings option from the shortcut menu; the Select Drawings to Process dialog box will
be displayed, as shown in Figure 2-14. The options in this dialog box are discussed next.
Drawing: The Drawing radio button is used to display the path and the name of all drawings
in a project. This radio button is selected by default.
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Description: Select the Description radio button; the description of all drawings will be
displayed in the top list of the Select Drawings to Process dialog box. Remember that the
description will be displayed only if you have entered the description in the Description
1/2/3 edit boxes in the Create New Drawing dialog box or in the Description 1/2/3 edit
boxes of the Drawing Settings tab in the Drawing Properties dialog box.

Select Drawings to Process @
@ Drawing  (7) Description
Rief Subfolder Section  Sub-Section Project Drawing List s
SCHEMATIC C:Users\CADCIMDocuments®Acad. .. \Ae DataprolNFP Adem
SCHEMATIC C\Users\CADCIM \Documents'Acad. .\ Ae Data'proj\NFP Adem| =
SCHEMATIC C:\Users\CADCIM \Documents'Acad. ..\ Ae Data"proj\NFF Adem
SCHEMATIC C\Users\CADCIM \Documents'Acad. .\ Ae Data"proj\NFP Adem —
SCHEMATIC C:\Users\CADCIM \Documents'Acad. ..\ Ae Data"proj\NFF Adem
SCHEMATIC C:\Users\CADCIM \Documents'Acad. ..\ Ae Data"proj\NFF Adem
CrUCRMATIT A e T AU TR Dimmit srmimimdbn s mmid % Am Dt m i RICD A me
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Figure 2-14 The Select Drawings to Process dialog box

Do All: Choose the Do All button to transfer all drawings from the top list to the bottom
list of the Select Drawings to Process dialog box.

Process: The Process button will be activated only if you select a drawing(s) from the top
list. This button is used to transfer the selected drawing from the top list to the bottom list.
To do so, select a drawing(s) and then choose the Process button; the selected drawing(s)
will be transferred from the top list to the bottom list of the Select Drawings to Process
dialog box. You can use the SHIFT or CTRL key to select more than one drawing at a time.

Reset: The Reset button will be activated only if you have transferred drawing(s) from the
top list to the bottom list. Choose the Reset button to reset the drawings to their original
positions in the dialog box.

Un-select: The Un-select button will be activated only if you select drawing(s) from the
bottom list. The Un-select button is used to transfer drawing from the bottom list to the
top list. To do so, select a drawing(s) from the bottom list and then choose the Un-select
button; the drawings will be moved from the bottom list to the top list. You can unselect
multiple drawings at a time by using the SHIFT or CTRL key.
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by Section/sub-section: The by Section/sub-section button is used to select the drawings
that have been grouped by specifying their sections and sub-sections. To do so, choose
the by Section/Sub-section button from the Select Drawings to Process dialog box; the
Select Drawings by Section/sub-section dialog box will be displayed. Specify the section
and sub-section codes in the Section and Sub-section edit boxes, respectively. Alternatively,
select the section and sub-section codes from the Section and Sub-section drop-down lists,
respectively. Next, choose the OK button from the Select Drawings by Section/sub-section
dialog box; the corresponding drawing(s) will be transferred from the top list to the bottom
list. Note that the Section and Sub-section drop-down lists display the section and sub-section
codes only if you have entered the section and sub-section values in the Sheet Values area
of the Create New Drawing dialog box or in the Drawing Settings tab of the Drawing
Properties dialog box.

by Subfolder: The by Subfolder button is used to select the drawings that have been
grouped in subfolders. To do so, choose the by Subfolder button from the Select Drawings
to Process dialog box; the Select Drawings by Subfolder dialog box will be displayed. Select
the subfolder(s) from this dialog box and choose the OK button; the drawings from the
selected subfolder(s) will be transferred from the top list to the bottom list. Note that the
Select Drawings by Subfolder dialog box displays the subfolders only if you have added
subfolders in the project.

After selecting drawings from the Select Drawings to Process dialog box, choose the OK button;
the Remove Drawing(s) from Project List message box will be displayed. In this message box,
choose the OK button; the selected drawings will be removed from the project list. Note
that the drawings will instantly be removed from the project list, but they will not be deleted
permanently from the folder where they are stored.

Assigning a Description to a Drawing

You can assign a three-line description to each drawing listed in your project. To do so, right-click
on the name of a drawing in the project; a shortcut menu will be displayed. Next, choose
Properties > Drawing Properties from the shortcut menu; the Drawing Properties dialog box
will be displayed.

By default, the Drawing Settings tab is chosen in the Drawing Properties dialog box. Enter
a description for the drawing in the Description 1/2/3 edit boxes. You can also select the
predefined description for your drawing from the Description drop-down list. Note that the
predefined description will be available only if you have entered the description for any of the
drawings of a project, as shown in Figure 2-15. This figure shows the predefined descriptions listed
in the Description 1 drop-down list of the Drawing Properties dialog box. Next, choose the
OK button; the drawing file will be updated and the changes will be saved.

/ Note

@ The description specified in the Description 1, Description 2, and Description 3 edit boxes of
the Create New Drawing or Drawing Properties dialog box can be linked to the attribute in
the title block for automatic update and will be discussed in the later chapters.
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Drawing Properties @
Drawing Settings | Components | Wire Numbers | Cross-Feferences | Styles | Drrawing Format
Drawing: CM\Users\CADCIM\Documents'AcadE 2017Ae Dataproj\NFP Ademao*demo(1.dwg

Drawing File

Project: NFPADEMO

Description 1: Flow and Interconnection diagram, 1/0 list H [ Pick>> ]
o 3phase motor control, Control circuit -

Description 2: Control schematic

Flow and Interconnection diagram, /0 list

Description 3: Main Control Panel layout
Operator Station layout
[T For Referenc: PLC 140 - Input Slet 5. Output Slot &
PLC 140 - Inputs - Slat 1
IEC - Style Designz PLC /0 - Inputs - Slots 3, 4
Power supplies, /0 module feeds

Project Code:

Figure 2-15 Partial view of the Drawing Properties dialog box
displaying predefined description

After adding description to a drawing, you can preview the description in the Details rollout
of the Project Manager. These drawing details give a unique identity to the drawings based on
users requirement and helps users to search a particular drawing among multiple drawings in
a project file.

Switching between the Drawings of an Active Project

Ribbon: Project > Other Tools > Previous DWG
Project > Other Tools > Next DWG
Toolbar: ACE:Main Electrical 2 > Previous Project Drawing

ACE:Main Electrical 2 > Next Project Drawing

ACE:Quick Pick > Previous Project Drawing

ACE:Quick Pick > Next Project Drawing
Command: AEPREV and AENEXT

<}:I |ED | The Previous DWG and Next DWG tools are used to open the previous and next

drawings of an active project. Using these tools, you can view and switch between

various drawings of a project. To do so, open any drawing of the active project and

then choose the Previous DWG or Next DWG tool from the Other Tools panel of the Project

tab. Alternatively, you can choose the Previous Project Drawing or Next Project Drawing tool

from the ACE:Main Electrical 2 or the ACE:Quick Pick toolbar. On doing so, the currently opened

drawing will be closed and all changes made to it will be saved. Also, the requested drawing will
open. The currently opened drawing will appear in bold text in the project list.

Tip

Q 1o open all drawings of an active project in a new window without closing the original
drawing window, hold the SHIFT key while choosing the Previous Project Drawing or
the Next Project Drawing button.

Note

1. You cannot view and switch among the drawings that are not associated with the active project.
2. You can use the Project Manager to preview the drawings easily using the Preview button.
3. If you move among various drawings using the up and down arrow keys, the selected drawing
will not open.
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Configuring the Drawing List Display

The Drawing List Display Configuration button is used to configure the information
related to various drawings in the Projects rollout of the Project Manager. This button is
used to display the required information such as drawing number, description, and so on.

By default, only the name of the drawing is displayed in the Projects rollout of the Project Manager,

as shown in Figure 2-16. Choose the Drawing List Display Configuration button from the

Project Manager; the Drawing List Display Configuration dialog box will be displayed, as

shown in Figure 2-17. The options in this dialog box are discussed next.

Display Options Area
. . . x
The Display Options area displays Fhe predefined v BERS@ZEES -
values that can be associated to a drawing. % | [NFPADEMO B
Projects = 'n;__\
Current Display Order i z
. . . =-E7 SCHEMATIC
The Current Display Order area lists the order in . -
which the required display options will be displayed in demob2.dwg 2
the Projects rollout in the Project Manager. The File demol3.dwg =
Name option is displayed by default in this area. You demobbdwg = |2
can add other display options in this area by selecting demo05.dug 2
. . demol6.dwg
them from the Display Options area and then choose A demolT.dwg
>> button. B ;QNEL

Figure 2-16 Partial view of the

>> . Project Manager displaying the drawing
The >> button is used to move only the selected ;
. S . . files of the project
display option from the Display Options area to the
Current Display Order area.
Drawing List Display Configuration @
Display Options: Cumrent Display Onder:
Installation Code (%) - w File Mame
Location Code (%L} &
Section
Sub Section =
Sheet Mumber (%5)
Drawing Number (%0}
Drawing Description 1 B
EJlawing Pescription ? - << All
Separator Value Maove Up
@) Always show selection highlight Move Down
() Show selection highlight only when active
[ ok || cancel || Hep |

Figure 2-17 The Drawing List Display Configuration dialog box

All>>

The All>> button is used to move all display options from the Display Options area to the
Current Display Order area.
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<<
The << button is used to move only the selected display option from the Current Display
Order area to the Display Options area.

<<All
The <<All button is used to move all display options from the Current Display Order area to
the Display Options area.

Separator Value

The Separator Value edit box is used to specify the character to be used as a separator between the
values in the listing. You can enter a character in the Separator Value edit box or use the default
character (-) in this edit box.

Move Up
Choose the Move Up button to move the selected display option one step up in the Current
Display Order area.

Move Down
Choose the Move Down button to move the selected display X[
option one step down in the Current Display Order area. W BHRSERES -O
2| | NFPADEMO -8
Projects - §__'
Choose the OK button in the Drawing List Display = = NFPADEMO B
Configuration dialog box; the entire information UmSCHENATIC
. . . . . 8 demalL.dwg - 0201 - Flov
related to drawings will be displayed in the Projects i demob2.dwg - 0202-3-pl | | 3
rollout, refer to Figure 2-18. I3 demo3.dug -0203 -Pow | |2
'™ demold.dwg - 0204 - Cor|= | | &
% demoD5.dwg - 0205 -PLC| | | 5}
Note @ demo06.dwg - 0206 - PLC
) ) 1 ) [ demol7.dwg - 0207 - PLC
@ The drawing options arve displayed in the Current - ot |

Display Order area in a particular sequence. The

same sequence is followed for their display in the —Figure2-18 Partial view of the Project
Projects rollout of the Project Manager. Ifyouwant ~Manager displaying the drawing
to change the sequence, choose the Move Up or Move ~ information

Down button.

Copying a Project

Ribbon: Project > Project Tools > Copy

Toolbar: ACE:Main Electrical 2 > Project Manager drop-down > Copy Project
or ACE:Project > Copy Project

Menu: Projects > Project > Copy Project

Command:  AECOPYPROJECT

The Copy tool is used to copy the entire project as well as copy the drawings present

E1  within that project. To do so, choose the Copy tool from the Project Tools panel of the

~ Project tab; the Copy Project: Step 1 - Select Existing Project to Copy wizard will be
displayed, as shown in Figure 2-19.
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Copy Project: Step 1 - Select Bxisting Project to Copy @
Enter existing project name [ Copy Active Project ]

Mote: if the active drawing is one of those to be copied to @ new project:
1. Cancel now.
2. Open a different or a new drawing.
3. Re-start this command.

[ ok | [ cancel | [ Heb |

Figure 2-19 The Copy Project: Step 1 - Select Existing Project to Copy wizard

Note
@ Before copying drawings to a new project, you need to close all drawings of that project.

Next, enter the name and path of the existing project in the Enter existing project name edit
box. Alternatively, choose the Browse button from this dialog box to select the existing project;
the Select existing project to copy dialog box will be displayed. Next, double-click on the
project folder that you want to copy. Select the project’s .wdp file and choose the Open button;
the name and path of the existing project will be displayed in the Enter existing project name
edit box. You can also choose the Copy Active Project button available in this dialog box to
copy the currently active project.

Choose the OK button; the Copy Project: Step 2 - Select path and name for new project wizard
will be displayed, as shown in Figure 2-20. Enter a name for the new project in the File name
edit box and select the path for the new project from the Save in drop-down list. By default, the
.wdp extension will be displayed in the Save as type edit box. Next, choose the Save button; the
Select Drawings to Process dialog box will be displayed, as shown in Figure 2-21.

A Copy Project: Step 2 -- Select path and narne for new project IEI

Savein: |, Mfpaliemo -8 5 = B

| SNl

EXPORTED_MOEB.. Mfpadermoswdp

File name: | - Save

Save az bype: ["_wdp v] ’ Cancel ]

Figure 2-20 The Copy Project: Step 2 - Select path and name for new project wizard

Select the drawing files that you want to copy in the project from the top list of this dialog box.
Next, choose the Process button; the selected drawings will be transferred from the top list of

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-20 AutoCAD Electrical 2017 for Electrical Control Designers

the Select Drawings to Process dialog box to the bottom list. The other options in the Select
Drawings to Process dialog box have already been discussed. Choose the OK button from the
Select Drawings to Process dialog box; the Copy Project: Step 4 -- Enter Base Path for Project
Drawings wizard will be displayed, refer to Figure 2-22.

Select Drawings to Process @
@ Drawing  (C) Deseription

Fief Subfolder Section  Sub-Section  Project Drawing List Il
SCHEMATIC C:AJzers\CADCIMAD ocumentshAcad.. \deD atahproj\NFPAdem
SCHEMATIC C:AJzers\CADCIMAD ocuments\Acad.. \deD ataprof\NFPAdem =
SCHEMATIC C:AJzers\CADCIMAD ocumentshAcad.. \deD atahproj\NFPAdem
SCHEMATIC C:AJzers\CADCIMAD ocuments\Acad.. \deD ataprof\NFPAdem —
SCHEMATIC C:AJzers\CADCIMAD ocumentshAcad.. \deD atahproj\NFPAdem
SCHEMATIC C:AJzers\CADCIMAD ocumentshAcad.. \deD atahproj\NFPAdem
CrUChAATICT b e AT TR T mms immmanbnh Sommd VA AT —beb mrmib RICDA Amrn kv

< [ | 3

Do Al ‘ Process f Reset f Un-zelect by Section/sub-section ] [ by Subfolder
Fief Subfolder Section  Sub-Section  Project Drawing List
4 1 | +

Select from the top list, - - "
insert into the battom list. ol Wiew

Figure 2-21 The Select Drawings to Process dialog box

Copy Project: Step 4 -- Enter Base Path for Project Drawings

CUsers CADCIM\Documents'Acade 2017 AeData"\Proj

Browse

it

The base path above will be substituted for this path in the existing project:
¢ wsers‘cadoimdocumentstacade 2017 aedata proj nfpademo’.

Copies of the drawings will be copied to this new path.
If the directory path does not exist, it will be created.

Select Project-Related Files to be Copied

[¥] Title Block Setup (wdt) Location Codes (loc)
Project Line Labels (wdl) Installation Codes (inst)
Component Description Defaults (wdd) Ratings Defaults (wdr)
Catalog Lookup Database (cat.mdb) Component Tagging (wdx)
Footprint Lookup Database {lookup mdb) Spreadsheet PLC /0 Ltility Settings {wdi)
Family Code Mapping (wd_fam.dat) RSLogix Import Mapping {.wdf)
Wire Color/Gauge Label {wdw) User Defined Attibutes { wda)
Schematic Lookup Database (schematic_lookup mdb) Teminal Audit Fitter {wdn)
oK | [ Camesl |

Figure 2-22 The Copy Project: Step 4 -- Enter Base Path for Project Drawings wizard
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Note

@ In case, there is no drawing file in the project to be copied, then the Select Drawings to Process
dialog box will not be displayed and the AutoCAD Message message box will be displayed. Choose
the OK button in this message box; the Copy Project: Step 4 -- Enter Base Path for Project
Drawings wizard will be displayed.

In this dialog box, enter the directory path where the new project will be saved. The directory path
will be created, if it does not exist. In the Select Project-Related Files to be Copied area, you
can specify the project related files that need to be copied to the project that you want to create.
Note that the project related files to be copied will be activated in the Select Project-Related
Files to be Copied area. To copy these files, select the check boxes on the left of the respective
files and then choose the OK button; the Copy Project: Step 5 -- Adjust new drawing file names
wizard will be displayed, as shown in Figure 2-23.

Copy Project: Step 5 -- Adjust new drawing file names @
C:/Users/CADCIM./Documents,/Acade 2017/ AeData/Proj/demoll.dwg

C:/Users/CADCIM/Documents. Acade 2017/ AeData/Proj/demol2 dwg
C:/Users/CADCIM/Documents. Acade 2017/ AeData/Proj/demol3.dwg
C:/Uzers/CADCIM/Documents/ Acade 2017/ AeData/Proj/demol4 dwg
C:/Users/CADCIM/Documents./Acade 2017/ AeData/Proj/demol5.dwg
C:/Uzers/CADCIM/Documents/ Acade 2017/ AeData/Proj/demolé.dwg
C:/Uzers/CADCIM/Documents/ Acade 2017/ AeData/Proj/demol7 dwg
C:/Users/CADCIM/Documents./Acade 2017/ AeData/Proj/demol8 dwg
C./Uzers/CADCIM/Documents/ Acade 2017/ AeData/Proj/demolS.dwg

[ Edt | [ Find/Replace |

[ ok | [ Cancel |

Figure 2-23 The Copy Project: Step 5 -- Adjust new drawing file names wizard

Choose the Edit button in this wizard to edit the file name and path of the selected drawing, if
needed. Similarly, choose the Find/Replace button to find or replace a drawing file name and
its path. Next, choose the OK button; the name of the new project will be displayed at the top
in the Projects rollout in bold text and will become the active project.

Deleting a Project

Ribbon: Project > Project Tools> Delete
Menu: Projects > Project > Delete Project
Command: AEDELETEPROJECT

Ej The Delete tool or the AEDELETEPROJECT command is used to delete an

existing project and its drawings permanently. To do so, choose the Delete tool from
the Project Tools panel of the Project tab; the Select Existing Project to Delete dialog box will
be displayed, as shown in Figure 2-24.

Enter the name of the project file to be deleted in the File name edit box. Alternatively, select a
project name from the list displayed in the Select Existing Project to Delete dialog box. Next,
double-click on the name of the project folder, if it exists. Select the project definition file(.wdp)
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and choose the Open button; the Project File Delete Utility dialog box will be displayed, as

shown in Figure 2-25. The options in this dialog box are discussed next.

| Extra Library Demo

4/13/2016 2:32 PM

A Select Existing Project to Delete @
Lookin: | Proj - Qo
MName = Date modified Ty

| Aegs 4/12/201612:56 PM Fi
. Demeo 4/13/2016 2:32 PM Fi

Fi

. NfpaDemo 4/27/201611:43 AM  Fi
, Point2Point 4/13/2016 2:32PM Fi
4| m | 3
File name: | - COpen
Files of type: ",wdp v] [ Cancel ]
| locste | [ FindFie.. |

Figure 2-24 The Select Existing Project to Delete dialog box

Delete “.wdp” project list file
The Delete “.wdp” project list file
check box is used to permanently
delete the selected project file with .wdp
extension.

Praject File Delete Utility

Caution
Thiz utility Deletes files.
There iz no "Unda.
It iz permanent!

[ Delete " wdp" project list file
o huzershe., Aprojhvestra library demobestra library demo.wdp

Delete project’s AutoCAD

drawing files
The Delete project’s AutoCAD drawing Liat
files check box is used to delete only the
drawing files of a project. Note that this
check box will be activated only if the
related project consists of drawing files.

[ Delete project's AutoCAD drawing files

Select from project's drawing file list

Cancel

Figure 2-25 The Project File Delete Utility dialog box

Delete Files

List

The List button will be activated only if you select the Delete project’s AutoCAD drawing files
check box. Choose the List button; the Select Drawings to Process dialog box will be displayed,
refer to Figure 2-21. Select the drawings to be deleted from the drawing file list of the project.
Next, choose the OK button from the Select Drawings to Process dialog box; the Project File
Delete Utility dialog box will be displayed again. Choose the Delete Files button from the
Project File Delete Utility dialog box; the selected files will be deleted permanently, and you
cannot retrieve them.

Other Options in the Project Manager
As discussed earlier, the Project Manager lists the drawing files associated with each project.
You can change the settings of a project by using the Project Manager, refer to Figure 2-26. The
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major tools and rollouts in the Project Manager have already been discussed. The remaining
ones are discussed next.

Buttons

Project selection drop-down list
Projects rollout

Project Drawing list
Details/Preview rollout

GUk 00 ho =

Buttons
There are several buttons available in the Project Manager such as Refresh, Publish/Plot, and
so on, see Figure 2-27. These buttons are discussed next.

BEMS o BEEES - @ bButns
|NFPADEMO F—#—————Project selection drop-down list

Prajects BE__' : Projects rollout
=-f= NFPADEMO
- 2B scHEmATIC

T X

| »

m

Project Drawing List

E demol3.dwg
i demold.dwg
5 demol5.dwg

Location View

-

Details B -
Status: Accessible
Sheet: 1
Description: Flow and
Interconnection diagram, IO list

»

File Mame: demo0l.dwg

m

Location: C:\Users\CADCIM
\Documents\AcadE 2017\ AeData
\proj\NFPAdemo Details/Preview rollout

File Size: 113KB (115758 bytes)
Last Saved: 2/6/2016 1:05:08 AM
Last Edited By: Autodesk -

» PROJECT MANAGER

Figure 2-26 larious components of the Project Manager

Project Task List Project-Wide Update/Retag
Refresh ——— T Drawing List Display Configuration
Mew Drawing Publish/Plot
MNew Proiect — — Help
Open Project —

BERS@EES -O
| NFPADEMOC [
| Projects -|
| &t NFPADEMO

Projects

Figure 2-27 Various buttons in the Project Manager
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Refresh
The Refresh button is used to freshen the drawing list present in the Project Manager.

™
=

Project task List
— | The Project Task List button will be activated only if there are pending updates for
1@?_ a drawing file. The Project Task List button is used to execute the pending updates
on any drawing file modified in the active project. Choose the Project Task List
button from the Project Manager or right-click on the active project; a shortcut menu will
be displayed. Next, choose the Task List option from the shortcut menu; the Task List
dialog box will be displayed. Select the drawing files that you want to update and choose
the OK button; the QSAVE message box will be displayed. Choose the OK button from the
QSAVE message box; the drawing(s) will be updated. The options in the Task List dialog
box are discussed in detail in Chapter 12.

Project-Wide Update/Retag

The Project-Wide Update Retag button is used to update the related line
|=—§I reference numbers, device tagging, cross-reference text, and signal reference

updates on the selected drawing files in an active project. Choose the Project-Wide
Update/Retag button from the Project Manager; the Project-Wide Update or Retag dialog
box will be displayed. Specify the required options in this dialog box and choose the OK
button; the Select Drawings to Process dialog box will be displayed. Now, select the drawings
that you want to process and choose the Process button. Next, choose the OK button; the
selected drawings will be updated. The options in the Project-Wide Update or Retag dialog
box will be discussed in detail in Chapter 6. You can also use the (WD_BUMP) command to
invoke the Project-Wide Update or Retag dialog box.

Publish / Plot
Choose the Publish/Plotbutton from the Project
Manager; the Publish/Plot drop-down willbe | gursezmEz® - |

displayed, as shown in Figure 2-28. The options | [nFadeuo Plot Project
. . Projects Publish to WEB
in the drop.-down of. the Publl.sh/ Plot buttf)n areused | T e S
to plot active drawings, publish the drawings of the SEIHMATC | e

active project to web, DWF, PDF, DWFx and zip the
active project. Choose the Plot Project option from the  Figure 2-28 The drop-down displayed
drop-down to batch plot one or more drawings in the choosing the Publish / Plot button
active project. The Plotting of drawings will be discussed

in detail in Chapter 12.

Help

@ When you choose the Help button from the Project Manager, the AutoCAD
Electrical 2017 - Help window will be displayed. Alternatively, choose Help from

the Help menu to display the AutoCAD Electrical Help window. This window helps

you understand different options, commands, and tools of AutoCAD Electrical.

Note
@ If you press FI or use the HELP command, it will also display the AutoCAD Electrical 2017
- Help window.
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Project selection Drop-down List © PROJECT MANAGER
The Project selection drop-down list is available at the BERSEAED -G
top of the Project Manager, as shown in Figure 2-29, and NFPADENO E
it consists of names of all open projects and following WDDEMO
options: MFPADEMO
EXTRA LIBRARY DEMO
POINTZPOINT
1. Recent
2. New Project Recent..
3. Open Project New Project..
4. Open Project from Vault Open Praject..

You cannot close any open project using the Project

Open Project frorm Wault..,

selection drop-down list. The other options in this  Figure 2-29 The Project Manager

drop-down list are discussed next.

displaying the Project selection
drop-down list

Recent

When you select the Recent option from the Project selection drop-down list, the Recent
Projects dialog box will be displayed. In this dialog box, you can view the recently opened
projects, view the drawings of the selected project, remove the selected project, and find the
drawings from the recent projects list displayed in the Recent Projects dialog box.

New Project

The New Project option is used to create a new project. To do so, select the New Project
option from the Project selection drop-down list; the Create New Project dialog box
will be displayed. The options in this dialog box have already been discussed. Specify the
required options and choose the OK button; the new project will be created and will appear
in bold text on the top of the list in the Projects rollout. Also, the newly created project will
automatically become an active project.

Open Project

The Open Project option is used to open an existing project. To do so, select the Open
Project option from the Project selection drop-down list; the Select Project File dialog
box will be displayed. Next, select the required project from this dialog box and choose the
Open button; the selected project’s name will automatically be displayed in the Projects
rollout in bold text and the project will become an active project.

Open Project from Vault
The Open Project from Vault option is used to open a project from Autodesk Vault. Vault
is a repository where documents and files are stored and managed.

Projects Rollout

The Projects rollout displays a list of all opened projects. You can open as many projects as you
want, but only one project can be active at a time. The active project appears in bold text and is
always displayed at the top of the list in the Projects rollout. When you right-click on the name
of the active project or on the project that is in bold text, a shortcut menu will be displayed, as
shown in Figure 2-30. The options in the shortcut menu are discussed next.
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Close

x
S . | BEHESIEES -
The Close option is used to remove the project : =

. . . . . # | |5 NFPADEMO [-] #
which is displayed in the Projects rollout. Projects -
m—‘at A
i d Close
Expand All '
. . Expand All
The Expand All option is used to expand a Collapse Al
project and subfolder(s) in a project, if any. Add Subfolder
: Flatten Structure
co“apse All Descriptions...
The Coll All . . d 1 e Title Block Update...
¢ Collapse option is used to collapse a Sty Drowing List Report.
project and subfolder(s) in a project, if any. N Flip DVWG Name to Lower Case
\Doc| Flip DWG Mame to Upper Case
“proj
Add Subfolder sort..

Mew Drawing...

The Add Subfolder option is used to add a

. u Add Drawings...
subfolder to a project. S o

Add Active Drawing
Remove Drawings...

Flatten Structure

» PROJECT MANAGER
=
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B

Sche Task List...
The Flatten Structure option is used to remove S Publish 5
subfolder(s) from the project to get a flat drawing Settings...
list in a project. Errremiliti.
Properties...
Descriptions Figure 2-30 The shortcut menu displayed

The Descriptions option is used to edit the by right-clicking on the active project in the
description of an existing project. Itis also used  Project Manager

to add description to a new project. To do so,

choose the Descriptions option from the shortcut menu; the Project Description dialog
box will be displayed, refer to Figure 2-6.

As the Project Description dialog box displays unlimited lines, you can enter the description
as per your requirement. The information that you enter in these lines can be re-used in
the Component, Bill of Material, and Wire reports that are generated for the project or
mapped to title block of the drawing. Select the in reports check box from the Project
Description dialog box to include the project description line information in report headers
and title blocks, which will be discussed in detail in the later chapters.

Title Block Update

The Title Block Update option is used to update the information of the title block for the
entire project drawing set or for the active drawing. To update the title block information,
right-click on the active project; a shortcut menu is displayed. Choose the Title Block Update
option from the shortcut menu; the Update Title Block dialog box will be displayed, as
shown in Figure 2-31. The options in this dialog box will be discussed in detail in Chapter
12. You can also update a title block by using the WD_TB command.

Drawing List Report

The Drawing List Report option is used to generate a report that lists the project drawing
information of title block such as file names, file date, time, sheet number, drawing
descriptions, sections, and so on. To generate a report, choose the Drawing List Report
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option from the shortcut menu or use the WD_DWGLST_PRO]J command; the Drawing
List Report dialog box will be displayed. The options in this dialog box are used to extract
the new drawing list report, display previous drawing list report, and select format file for
report. You will learn more about the generation of reports in Chapter 9.

Update Title Block @
Select Line(s] to Update [Project Description Lines)
[T Title 1: Sample Project - Schematics [71 LINE13 [blank)
7] Title 2: (blanik] ] LINE14 [blank)
[T Tite 3 (blank] [T1 LINE1S [blank)
[T] JobMumber: [blank] [] LIME1E [blank)
[ Date: (blank] [T1 LINE17 [blank)
[T] Engineer: (blank] [T1 LINE1S [blank)
[T] Drawn By (blank) [] LIME19 [blark)
[7] Checked By: (blank] [71 LINEZ2O [blank)
7] Scale: (blank) [T] LMEZA [blark]
[T] UKME1D (blank] 71 LINEZ2 [blank)
7] LNEN (blank] [[] LNEZ3 [blank)
7] umE1Z (blank] 7] LinE24 [blank)
Select lines] to update [these are per-drawing values|
7] Drawing Description: El1 B2 B3 1P [0 [ L [P 21%L values)
7] Drawing Section [Section in project] ] Drawing (%D valug)
[T] Drawing Sub-section [Sub-section in prajsct] [ Shest (%5 valug) [ Previous (%5 valug] [ Mewt (%5 valug)
[C] Filename: Drawing UPPEIesse [ gheat maimum: El
7] Filetextension: Drawingl.dwg
7] Full Filename: C:AUsersh...ments\Drawingl.dwa I7] Resequence shest %3 values
Activate each drawing to process
0K Active Drawing Onlp 0K, Project-wide [ Cancel ] [ Help ] [ ‘wide> ]

Figure 2-31 The Update Title Block dialog box

Task List

The Task List option will be activated only if an active project has pending updates on any
drawing file which is present within the active project and has been modified. Choose the
Task List option from the shortcut menu; the Task List dialog box will be displayed. The
options in the Task List dialog box will be discussed in Chapter 12.

Publish

When you right-click on an active project and move the cursor to the Publish option of
the shortcut menu, a cascading menu will be displayed, as shown in Figure 2-32. This
cascading menu consists of various options such as Plot Project, Publish To WEB,
Publish To PDF/DWF/DWFx, and Zip Project. Choose the Plot Project option to plot
one or more drawings in the active project. The Publish To WEB, Publish To PDF/DWF/
DWFx, and Zip Project options are used to publish the project to web, pdf, dwf, dwfx and to
create the zipped file of a project, respectively.

Settings

When you choose the Settings option from the shortcut menu, the Current Settings dialog
box is displayed. This dialog box displays settings of a project and information about
AutoCAD Electrical environment.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 2-32 Various Publish options displayed
in the cascading menu

Exception List

When you choose the Exception List option from the shortcut menu, the Properties
Exception List dialog box is displayed, as shown in Figure 2-33. This dialog box displays the
list of drawing files that possess the properties different from the project definition file
(*.WDP). Figure 2-34 shows the Properties Exception List dialog box that will be displayed if
the settings of all drawing files of a project match with the settings of the project definition
file. Also, this dialog box displays that there are no exceptions.

. Note

@ You can view the difference between drawing properties and project defaults. To do so, choose

o Settings Compare from the Projects menu or choose the Settings Compare buiton from the
Drawing Properties drop-down in the ACE:Main Electrical 2 toolbar; the Compare Drawing
and Project Settings dialog box will be displayed. This dialog box is used to compare the drawing
and project default settings.

Properties
On choosing the Properties option from the shortcut menu, the Project Properties
dialog box will be displayed, as shown in Figure 2-35. You can use this dialog box to edit
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and modify the properties for project settings, components, wire numbers, cross-references,
styles, and drawing format. The editing of project properties will be discussed in detail in

Chapter 12.

Properties Exception List: MFPADEMO

\ These drawing(s) have different properties than the project defaults. Use the Settings
¢ I\ Compare function to display differences.

File Name: demol1.dwg
Status: Accessible
Location: C:\Users\CADCIM\Documents‘\AcadE 2017 AeData"projf\NFP Ademo

File Name: demol2 dwg
Status: Accessible
Location: C:4Users\CADCIM \DocumentsAcadE 2017 AzData proj M FPAdema

File Name: demol3.dwg
Status: Accessible
Location: C:\Users\CADCIM \Documents®AcadE 2017 AeData"proj"NFP Ademo

File Name: demo4.dwg

Status: Accessible
Location: C:\Users\CADCIM\Documents’\AcadE 2017 AeData"proj'NFP Ademo

==

»

m

Figure 2-33 The Properties Exception List dialog box

Properties Exception List: 1

All drawings match the project defaults.

Figure 2-34 The Properties Exception List dialog box
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Project Properties

Project Settings | Components I Wire Mumbers I Cross-References I Styles I Drawing Format

Project:  C:\Users\CADCIM“Documents*AcadE 2017 AeData proj NFP Ademo \NFPAdemo wdp
= Library and lcon Menu Paths

-

D Schematic lcon Menu File

E Panel Footprint Libraries

D Panel lcon Menu File

Add

Remaove
Move Up

Maove Down

i Catalog Lookup File Preference

@ Use component specific tables
() Always use MISC_CAT table
(71 Use MISC_CAT table only if component specific table does not exdst

il Options

Real time emor checking

Other File... (none defined)

Tag / Wire Number / Wire Sequence Sort Onder:
Mo Project Default -

Electrical Code Standard:
Default (National Blectrical Code) -

[ ok [ Canesl |[ Hel

Note
The options discussed above will be displayed if you right-click on an active project in the Projects
rollout. But if you right-click on an inactive project, a shortcut menw with the Activate option
will be displayed, as shown in Figure 2-36. If you choose this option from the shortcut menu, the
selected project will become active and will be displayed at the top of the projects list in bold text.

Figure 2-35 The Project Properties dialog box

Project Drawing List
The Project Drawing list displays the drawings available in a project. If you double-click on
a project name in the Projects rollout of the Project Manager, the drawings associated with
that project will be displayed. Right-click on a drawing file name; the editing options will be
displayed, as shown in Figure 2-37. Using these options, you can open, close, remove, rename,
and replace a drawing file. You can also edit the properties of a drawing by choosing Drawing
Properties from the shortcut menu, refer to Figure 2-37. The options in this shortcut menu are
discussed next.
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Figure 2-36 The shortcut menu displaying Figure 2-37 The editing options available
the Activate option in the shortcut menu

File Size: 113KB (115758 bytes)
Last Saved: 2/6/2016 1:05:08 AM
Last Edited By: Autodesk L4

3 PROJECT MANAGER
» PROJECT MANAGER

. Note

@ You can convert a drawing file into a reference drawing. 1o do so, right-click on the drawing
name and choose Properties > Drawing Properties from the shortcut menu; the Drawing
Properties dialog box will be displayed. Select the For Reference Only check box from the
Drawing Settings tab; the drawing file will be converted into reference drawing. However; its
extension (.dwg) will remain the same.

Open

On choosing the Open option from the shortcut menu, the selected drawing will open in a
new window and its name will appear in bold text in the Project Drawing list. Alternatively,
you can select a drawing file name and press ENTER to open the corresponding drawing.
You can also open a drawing file by double-clicking on it. The OPEN command is also used
to open a drawing file.

Close

Choose the Close option from the shortcut menu to close the current drawing file. This
option will be available only if the drawing file is open. You can also close a drawing file by
using the CLOSE command.

Copy To

The Copy To option is used to copy the selected drawing to the same or another open
project. To do so, choose the Copy To option from the shortcut menu; the Copy To dialog
box will be displayed, as shown in Figure 2-38. Next, from the Save in drop-down list, select
the location where you want to copy the drawings. If you want to change the name of the
drawing file, enter the drawing file name in the File name edit box. Next, select the project
name from the Project drop-down list. Choose the Save button; the Apply Project Defaults
to Drawing Settings message box will be displayed. Choose the Yes button in the message
box to apply the project default values to the newly added drawing’s WD_M block definition;
the selected drawing(s) will be copied to the specified project. If you want the new drawing
to retain its existing settings, choose the No button.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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A CopyTo @
Savein: [ (GG - & % Al FEE
T= Name : Date Type Size Tags
el |EXPORTED... 4/13/20165... File folder
Recent Places DEMOOL 2/6/2016 ... AutoCAD .. 114 KB
- DEMQ02 2/6/20161:..  AutoCAD ... 149 KB
DEMQO3 2/6/20161:...  AutoCAD ... 94 KB
Desktop DEMO04 2/6/20161:...  AutoCAD ... 109 KB
— DEMOO5 2/6/20161:...  AutoCAD ... B3 KE
— DEMO0G 2/6/2016 11, AutoCAD ... 135 KB
Libraries DEMQO7 2/6/20161:...  AutoCAD ... 122 KB
DEMOOS 2/6/20161:...  AutoCAD ... BLKE
Es&.h DEMO03 2/6/20161:..  AutoCAD ... 170 KB
Computer
=
1Y
Metwork
File name: ab -
Save as type: ’DWG Files (".dwg) v] ’ Cancel ]
Project: [NFPADEMO -]

Figure 2-38 The Copy To dialog box

Remove
Choose the Remove option from the shortcut menu to remove the selected drawing from
the current project. This option does not remove the drawings permanently.

Replace

The Replace option is used to replace the selected drawing with the desired one. To do
so, choose the Replace option from the shortcut menu; the Select Replacement Drawing
dialog box will be displayed, as shown in Figure 2-39. Next, select the drawing file and
choose the Select button; the Apply Project Defaults to Drawing Settings message box
will be displayed, refer to Figure 2-9. Choose the Yes button to apply the project default
values to the newly added drawing’s WD_M block definition. If you want the new drawing
to retain its existing settings, choose the No button; the drawing file will get replaced with
the selected drawings. This drawing will be displayed in the Project Drawing list. Also, note
that if the drawing is already present in the project, it will display the message that drawing
is already present in the project.

Rename

The Rename option is used to rename the selected drawing. To do so, choose the Rename
option from the Project Drawing list; the name of the selected drawing will be replaced by
an edit box. Enter a new name in the edit box to rename the drawing.
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Figure 2-39 The Select Replacement Drawing dialog box

Drawing Properties

The Drawing Properties option is used to change the drawing settings, component tag
format, wire number format, cross-reference format, styles, and drawing format. Also, you
can edit, assign, and remove the section and sub-section codes of a drawing. To do so, choose
Properties > Drawing Properties from the shortcut menu; the Drawing Properties dialog
box will be displayed. In the Drawing Properties dialog box, you can assign descriptions
to the drawing files. Note that each individual drawing can have its own drawing settings
for designing purpose.

Apply Project Defaults

Choose the Apply Project Defaults option from the shortcut menu to apply the project
default settings of the project to the new drawing files, if it was not done while creating the
drawing files.

Copy
You can copy drawing settings and options from one drawing to one or more drawings by
choosing the Copy option from the shortcut menu.

Note
The drawing-specific information that is displayed in the Drawing Settings tab of the
Drawing Properties dialog box cannot be copied from one drawing to anothes; refer to Figure 2-8.

Paste
Choose the Paste option from the shortcut menu to apply the copied drawing settings as
well as other options from one drawing to other selected drawing(s).

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-34 AutoCAD Electrical 2017 for Electrical Control Designers

Settings Compare

The Settings Compare option is used to compare the drawing with its project settings. To
do so, choose the Settings Compare option from the shortcut menu; the Compare Drawing
and Project Settings dialog box will be displayed, as shown in Figure 2-40. This dialog box
displays the difterences between the drawing settings and their associated default values in
the project definition file (wdp). See Figure 2-40, where demo01.dwg is the drawing name
and NFPADEMO is the project name.

Compare Drawing and Project Settings: dermo0l.dwg Versus NFPADEMO @
() Show Al
©® Show Differences Select Al Maich Project | | Match Drawing |
Settings Description Drawing Project
Wire layers BLK* WHT* RED* GRN* WIRES* [WIRES
XREF_TBLFLDMANS W1,T1,TYPE, T2, W2 REF, SH SH|W1,T1,TYPE T2, W2,REF SH,S5H
[ ok | [ cancel | | Hep |

Figure 2-40 The Compare Drawing and Project Settings dialog box

Details/Preview Rollout

The Details/Preview rollout displays the details of the selected project or drawing as well as the
preview of the selected drawing. The Details and Preview rollouts shown in Figure 2-41 and
Figure 2-42, respectively are discussed next.

Details
= The Details button is used to view details of the selected project and drawing. To do so,
select a project or drawing from the Projects rollout and then choose the Details button
from the Details/Preview rollout in the Project Manager; details of the selected project
or drawing will be displayed in the Details rollout. Whenever you select a drawing file, its details
get updated and remain visible till you select a new drawing file. The information that will be
displayed in the Details rollout includes status, description if added, file name, file location, file
size, date when the file was last saved, the name of the user who modified the file last, and so
on, refer to Figure 2-41.
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Note
You can switch/move from one drawing to another by using the wp and down arrow keys.

Preview
The Preview button is used to display the preview of the selected drawing in the Preview
E rollout. To preview a selected drawing, select the drawing from the Projects rollout and
then choose the Preview button from the Details/Preview rollout; the image of the
selected drawing will be displayed in the Preview rollout, refer to Figure 2-42. The image of the
selected drawing will be visible till you select another drawing from the Projects rollout. You
can use up and down ARROW keys to view all drawings of a project.

Details EE -

Status: Accessible -
Sheet: 2 (l
Description: 3-phase motor Preview EE -
control, Control circuit

File Mame: demo02.dwg

m

Location: C:h\Users\CADCIM
‘\Documents\AcadE 2017 AeData
\proj\NFPAdemo

File Size: 148KB (152407 bytes)
Last Saved: 2/6/2016 1:05:08 AM
Last Edited By: Autodesk —

-

Figure 2-41 The Project Manager ~ Figure 2-42  The Project Manager
displaying the Details rollout displaying the Preview rollout

Note

@ As discussed in the previous section, you can use the Project Manager to preview drawings.
Moving between drawings by using the up and down ARROW keys does not open a drawing; it
only changes the preview or the details displayed in the Project Manager.

Location View TAB T
The options in the Location View tab of the Project Manager are used to display and
filter the components based on the installation and location codes, display details and
connections of the components, and so on. Figure 2-43 shows the Project Manager with the
Location View tab chosen. The options in this tab are discussed next.

Filter by Installation and Location
@ »| This button is used to filter components in the Component Tree as per the installation
and location codes. When you click on the down arrow of this button, a flyout is displayed,
refer to Figure 2-44. This flyout consists of various combinations of installation and
location codes available in the active project as options. You can click on any of these options
to view or hide components in the Component Tree based on the requirement.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 2-43 The Project Manager Figure 2-44 Flyout displayed on choosing the
with the Location View tab chosen Filter by Installation and Location button

Refresh Tree for Local Changes

#~| Thisbutton is used to refresh the Component Tree, the Details pane, and the Connections
s pane based on the changes made in the current session.

Search Field

This field is used to specify the search text such as component name, installation code, or
location code.

Go

This button is used to search the text entered in the Search field.

Component Tree

The Component Tree displays a list of all the components available in the active project. It has
various nodes. The main node is the active project node. When you expand this node, a node
representing installation code will be displayed. When you expand this node, all location code
nodes will be listed as separate nodes. You need to expand these nodes to view the components
with these installation/location codes as separate nodes. This list also includes PLC modules,
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connectors, cable markers, and terminals. You need to expand these component nodes in the
Component Tree to view pin information of the components, refer to Figure 2-45. When you
hover the cursor over a component, the detailed information about the component such as
catalog information, assembly code, description is displayed, refer to Figure 2-46.

B FLOOR
B O DIsc207
& (77 {Pin 1}
5 (27 Pin 2)
& (27 {Pin 3} O PLCEO2
5 (27 Pind) O PLCE22
o (7) {Pin 5} O PLY Electrical Only Component Tag: PLC602
& (27) {Pin 6} O TB{ Manufacturer: AB
© pIsc211 © TBy Catalog Number: 1771-1AD
© [DIsC215 © TB{ Assembly Code:
B O MTR208 © TB{ Description:
5 (27 Pin 1) © TB{ RACK 00
5 (27) Pin 2) B FLOOR |s510T3
G (77) {Pin 3} © DI 120V INPUTS
5 27 Pind) O DIStzrr
© MTR212 O DISC215
B o MTRZlﬁ O MTR208

Figure 2-45 The pin information of  Figure 2-46 The detailed information
the components of the component

You will notice that there are different icons on the left of each component. The significance of
these icons is explained in Table 2-1.

Table 2-1 The significance of icons

AutoCAD Electrical component not linked to an Inventor component

Inventar cormponent not linked to an AutoCAD Electrical component

Linked AutaCAD Electrical and Inventor components with no mismatches in data

Linked AutaCAD Electrical and Inventor components with some mismatch between the data

AutoCAD Electrical cable not linked to Inventar cable

Inventor cable not linked to AutoCAD Electrical cable

Linked AutoCAD Electrical and Inventor Cable with no mismatches in data

Mld|ex| 8B (% |0

Linked AutoCAD Electrical Inventor cable with sorme mismatch betuween the data

To expand or collapse all the nodes in the Component Tree, right-click on any of the installation
or location nodes and choose the respective option from the shortcut menu displayed, refer to
Figure 2-47.

When you right-click on an individual component node, a shortcut menu will be displayed, refer
to Figure 2-48. Choose the Surf option; the Surf dialog box will be displayed. In this dialog box,
related references of the component are displayed. The options in this dialog box are discussed
in detail in Chapter 6.
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Figure 2-47 The shortcut menu displayed on  Figure 2-48 The shortcut menu displayed on
right-clicking an installation/location node right-clicking a component node

Display Details and Connections
This button is used to expand the Project Manager with two additional tabs: Details and
Connections. These two tabs are discussed next.

Details Tab

When you choose this tab, the Details pane is displayed. Choose the installation or location
node in the Project Manager; a list of components in this node will be displayed in a grid in
the Details pane, refer to Figure 2-49. You need to scroll horizontally in the pane or increase
the size of the pane by stretching it horizontally to view all the columns in the grid. If you select
an individual component node in the Project Manager, the tabular information of only that
component will be displayed in a grid.

x . A
wl @~ (2B @ || petsis | Connections
® \Type here to search.. | (i) Information updated at 4/28/2016 12:43:57 PM Export *;3
NFPAdemo.wdp g/
B Tag  Manufacturer  Catalog Number Description 1 | Ter | | &
A %_ffllé {SINGLE} o O |pisca07 |8 194E-A25-1753
%8 FLOOR O |pisca11]ae 104E-A25-1753 _
E © DIsc207 O |Discais|as 194E-A25-1753
4 enPiny O [mTR208 |48 1329RS-7A00518VNH | CONVEYOR MOTOR E
j?g (?ZJ {Pin 2} O |MTR212 [AB 1329RS-ZA00518VNH | HYDRAULIC MOTOR 5
o3 O |mTR216 |28 1320RS-ZA00518VNH | INDEXING MOTOR 8
o Bl O [pL2o7 5
4 (7 Pin 5}
4 (77) Pin 6} O [pL207 [HuBBELL MRMS22425
© DISC211 o pL211
© DIsC215 O |PL211  |HUBBELL MRMS22425
© MTR208 SIhmE
© MTR212 -
= VD O[PL215  [HUBBELL MRMS22425
O PL20T: [
© PL207: [P]
© PL211:[]
g © PL211: [P]
ES O PL215: (]
E © PL215: [P)
= JBOXL
g MACHINE
S MCABS - N
& OPSTA3 8 [l ]
" hd

Figure 2-49 The Details pane with tabular information

If you right-click on the column name of the grid, a shortcut menu will be displayed, refer to
Figure 2-50. The options in this shortcut menu are used to add or remove columns from the
Details pane and to restore default number of columns. Similarly, if you right-click on the cell(s)
or row(s) in the grid, a shortcut menu will be displayed, refer to Figure 2-51. This shortcut menu
consists of two options: Copy and Surf. The Surf option is already discussed in the Component
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Tree. The Copy option will be activated only when you select cell(s) or row(s) in the grid. Using
this option, you can copy the content of the selected cell(s) or row(s).

The Export button located at the top right corner of the Details pane is used to export the
data in the grid to .xIs or .csv file. Note that in the export process only the data that is currently
displayed in the grid will be exported.

Details | Cennections
(:D Information updated at 8/11/2015 %:15:37 AM Export
T At e PP Description 1
[[ohsq ¥ Tag
O I5q v Manufacturer
© psq v Catalog Number
O fiR L VEYOR MOTOR
v Description 1
O JiTR RAULIC MOTOR Details | Connections
© Wt ¥ Terminal Strip EXING MOTOR -
O |2d | v | Item Number (i) Information updated at 8/11/2015 9:15:37 AM Export
8 Ié‘]: Assembly Code Tag  Manufacturer  Catalog Number Description 1
ol Category O }ISC207 |AB 194E-A25-1753
JE s O Jis Copy “+C b5 1753
Q121 Mare..
ore O [ITR <& Surf [ZA00518VNH | CONVEYOR MOTOR
Restore all columns to defaults O |iTR212 |AB 1329RS-ZA00518VNH | HYDRAULIC MOTOR

Figure 2-50 The shortcut menu displayed — Figure 2-51 The shortcut menu displayed on
on right-clicking on the column name right-clicking on the cell(s) or row(s) in the grid

Connections Tab

When you choose this tab, the Connections pane is displayed. Choose the installation or location
node in the Project Manager; the tabular information about wiring of the components in this
node will be displayed in a grid in the Connections pane, refer to Figure 2-52. You need to scroll
horizontally in the pane or increase the size of the pane by stretching it horizontally to view all
the columns in the grid. If you select an individual component node in the Project Manager,
the information regarding that component will only be displayed in the grid.

: Q- 2B @ || petais | connections
k2] \Type here to search... | (i) Information updated at 4/28/2016 12:43:57 PM Export *;2
NFPAdemeowdp g
O] Wire Number | From Location | From Component | From Pin | Tol [
=B gFP[‘?\;’]E’“D = O 2074 FLOOR PL207 : ] 1 FLOCE]
8 @) 0|07 FLOOR DIsC207 o || -
o @ o O [2088 FLOOR DISC207 FLOC
© 77) ohy O |208a FLOOR. PL207 : ] 2 FLOC E
© (7)o O [208F FLOOR MTR208 FLOC £
g g:} :g:; O [208e FLOOR PL207 : ] 3 rod | %
o 7 ion 02118 FLOOR PLZLL: (] 1 FLOC 3
o @2 on o218 FLOOR DISC211 Lo
© GND209 i [To]212r FLOOR. MTR212 FLOC
© GND213 - EIEES FLOOR PLZLL: 1] 3 FLOC
8 gzgi; O |z1z8 FLOOR DISC211 FLOC
= & rerey o [212a FLOOR PLZ11: 1] 2 FoC
O GND22e O |z15a FLOOR. PL215: ] 1 FLOC
© GND229 O |a1s8 FLOOR DIsC215 FLOC
. © GND310 o [216F FLOOR MTR216 FLOC
g g gzggﬁ O [2168 FLOOR PL215: ) 3 FLOC
z = v O [z168 FLOOR DISC215 FLOC
= O PLCS02 O |2168 FLOOR. PL215: ] 2 FLOC
G O PLCS03 o [208c FLOOR MTR208 FLOC
E © PLCE0Z o 212¢ FLOOR MTR212 FLocE]
o« Q PLC622 B 1] ] ]
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Figure 2-52 The Connections pane with tabular information
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If you right-click on the column name in the grid, a shortcut menu will be displayed, refer to
Figure 2-53. The options in this shortcut menu are used to add or remove columns from the
Connections pane and to restore default number of columns. Similarly, if you right-click on
the cell(s) or row(s) of the grid, a shortcut menu will be displayed, refer to Figure 2-54. This
shortcut menu consists of two options: Copy and Surf. The Surf option is already discussed in
the Component Tree. The Copy option will be activated only when you select cell(s) or row(s)
in the grid. Using this option, you can copy the content from the selected cell(s) or row(s).

Details | Connections

(D Information updated at 8/17/2015 %:19:27 AM

Wire N £ Locati E c

ol v wire Mumber
_g From Installation
—g v From Location
o
Tg|| ¥ FromComponent
(o] v FromPin
—% v ToPin Details | Cennections
[l || (£ o/ Component (i) Information updated at 8/17/2015 &
_F v To Location
T . Wire Number | From Location
o To Installation 4 I
o] S
=1 More... Moz Copy Ctrl=C
Q
m o Restore all columns to defaults o 21[:1 @ Surf

Figure 2-53 The shortcut menu displayed on  Figure 2-54 The shortcut menu displayed on
right-clicking on the column names right-clicking on the cell(s) or row(s) of the grid

The Export button located at the top right corner of the Connections pane is used to export the
data in the grid to .xls or .csv file. Note that in the export process only the data that is currently
displayed in the grid will be exported.

a

Note

1. If the project you are working is an electromechanical project and you are linking it with Au-
todesk Inventor, some additional buttons will be available in the Project Manager such as Filter
the view by link status, Refresh the data from Inventor, and so on. Also, some additional
shortcut menu options will be available for the grid.

2. You can link AutoCAD Electrical component to the Inventor part or vice-versa. 1o do so,
right-click on Inventor part or AutoCAD Electrical part and choose Assign to Existing in
Component Tree from the shortcut menu displayed. The selected components will be linked with
some differences. You need to resolve these differences using the Details and Connections pane
in the Location View tab.

3. 1o insert connector from the Location View tab in the Inventor assembly of the electromechanical
project, right-click on a node or a connector and then choose Insert Connector (From List) from
the shortcut menu displayed.
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TUTORIALS
Tutorial 1

In this tutorial, you will create a new project and add project description to it, refer to Figure 2-55.

You will also create a new drawing in the project.

(Expected time: 10 min)

The following steps are required to complete this tutorial:

a. Create a new project. | PROJECT MANAGER

b. Open the CADCIM project. BERSEES - o

c. Create a new drawing.

|capcm [-] 8

Creating a New Project e o8

1. Start AutoCAD Electrical 2017 by choosing PR C02 tutOLdwg
Start > All Programs (or Programs, if you '"H EXTRA LIBRARY DEMO | —
are working with Windows XP Classic appearance % 5 NFPADEMO :
mode) > Autodesk > AutoCAD Electrical 2017 '"H POINT2POINT 2
> AutoCAD Electrical 2017(Windows 7). -t WDDEMO s
Alternatively, double-click on the shortcut icon S
of AutoCAD Electrical 2017 on the desktop of betale A -
your computer to start AutoCAD Electrical 2017. — —

Description: -

2. The Project Manager is displayed by default File Name: C02_tut01.dwg
on the left of the screen. If it is not displayed, Location: CAUser\CADCIM.
choose the Manager tool from the Project \Documents\AcadE 2017
Tools panel of the Project tab. Alternatively, \AeData\prof\CADCIM
choose the Project Manager tool from the File Size: 48KB (49412 bytes) | _
ACE:Main Electrical 2 toolbar to display the Last Saved: 4/29/2016 11:02:42 |~
Project Manager. Lot Ecite By: CADCIM

3. Inthe Project Manager, make sure the Projects e
tab is chosen. Next, choose the New Project
button; the Create New Project dialog box is  Figure 2-55 The Project Manager
displayed, as shown in Figure 2-56. displaying the CADCIM project and its

description

4. Enter CADCIM in the Name edit box.

5. To specify the location of the project, choose the Browse button; the Browse For Folder
dialog box is displayed. By default, the Proj folder is selected in this dialog box. Choose the
OK button; the location of the project is automatically displayed in the Location edit box.

6. Select the Create Folder with Project Name check box, if it is not already selected.

7. By default, the name and path of the existing project is displayed in the Copy Settings from

Project File edit box as c¢:\Users\User Name\Documents\AcadE 2017\AeData\proj\NFPAdemo)
NFPAdemo.wdp. If it is not displayed, choose the Browse button; the Open dialog box is
displayed. Select the NFPAdemo folder and then select the NFPAdemo.wdp project file.
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Create Mew Project @

Name:

Location:

C:\Users\CADCIM\Documents'AcadE 2017\AsData'proj

Create Folder with Project Mame
CiUsers\CADCIM \Documents\AcadE 201 7 AeDatatproj'

Copy Settings from Project File:

C:\Users\CADCIM\DocumentsAcadE 201 7\AeData'proj\NFF Adema"\NFPAdemo wdp
OK - Propetties... OK [ Cancel | [ Hep |

Figure 2-56 The Create New Project dialog box

Next, choose the Open button; the path and name of the existing project is displayed in
the Copy Settings from Project File edit box.

8. Choose the Descriptions button from the Create New Project dialog box; the Project
Description dialog box is displayed.

9. Enter the following information in the Project Description dialog box, as shown in
Figure 2-57.

LINE1= CADCIM
LINE2= AutoCAD Electrical
LINE3= Sample Project

LINE4=1

LINE5S= 12/08/2015
LINE6= Sham
LINE7= John
LINE8= Crystal
LINE9= 1.00

Next, select the in reports check box corresponding to each of these lines to include this
description in the reports, refer to Figure 2-57.

> Note

@ The information that you enter in the description lines of the Project Description dialog box will
be displayed at a particular location in the title block of the drawing, as shown in Figure 2-58.
The title blocks will be discussed in detail in Chapter 12.
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10. Choose the OK button from the Project Description dialog box to save the changes made
in this dialog box.

Project Description (for report headers and title block update) @
Line1 [cADCIM | [Zlin repors
Line2 [AtoCAD Electrical | [Zlin repors
Line3 |Samp|e Project | [¥]in reports
Line4 [1 | [¥]in reparts
Line5 [29/04/18 | [lin repors
Line6 |Shan'| | [¥]in reports
Line7 |John | [¥]in reports
Line8 |C;ygta| | [¥]in reports
Line9 |1,|]-D | [¥]in reports
Line 10 | | [[]in reports
Line11 | | [[]in reports
Line12 | | [[]in reports

[ ok | [ Cancel | : ‘

Figure 2-57 The Project Description dialog box

11. Choose the OK button from the Create New Project dialog box. You will notice that
the CADCIM project appears in bold text at the top of the project list displayed in the
Project Manager, refer to Figure 2-59.

12. Next, select the CADCIM project from the Project Manager.

13. Choose the Details button from the Details/Preview rollout. You will notice that the project
description/information entered in the first nine lines of the Project Description dialog box
is displayed in the Details/Preview area, as shown in Figure 2-59.

> Note
@ 1. It is recommended to save all the tutorials in the forthcoming chapters in the CADCIM project.

2. If the CADCIM project is not displayed in the Projects rollout of the Project Manager, select
the Open Project option from the Project selection drop-down list; the Select Project File dialog
box is displayed. Select the Proj folder from the Look in drop-down list and then double-click on the
CADCIM folder name. Next, select the CADCIM file and choose the Open button; the CADCIM
project is displayed in the Projects rollout and it becomes the active project.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Creating a New Drawing
1. In the Project Manager, choose the New Drawing button; the Create New Drawing dialog
box is displayed, as shown in Figure 2-60.

© PROJECT MANAGER

B RS EES -
[capam [-]
Projects -
- CADCIM
) fe EXTRA LIBRARY DEMO
& fs NFPADEMO
#/-fe POINT2POINT
-t WDDEMO

| Projects

Location View

CADCIM

AwtaCAD Electrical —
Sample Project

| Line1

— Line2
— Line3

ENGNEER

CHECKED BY

Details

B -

\CADCIMM\AppDatatRoaming -
“Autodesk\AutoCAD

Electrical 2017\R21.04enu
YSupportiusenCADCIM.mdb

Line 1: CADCIM =
Line 2: AutoCAD Electrical

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

Lines —p— Sham. _Crystel —1— Lined Line 3: Sample Project
Lined 1= Johm  —1— Line7 Lined:1 L
SCALE DATE - =
Line9 —}— 1.00 29,/04 /16 —}— Line5 Line 5: 29/04/16
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Line &: Crystal —
(SHEET Mo 7 Line 9: 1,00
OF hd
. J

Figure 2-58 The title block showing the
description entered in the Project Description
dialog box

Figure 2-59 The Project Manager displaying the
CADCIM project and its description

2. Enter C02_tut01 in the Name edit box.

3. To specify the template in the Template edit box, choose the Browse button; the Select
template dialog box is displayed. In this dialog box, select ACAD_ELECTRICAL.dwt from
the list displayed and then choose the Open button; the name and path of the template is
displayed in the Template edit box.

4. Clear the For Reference Only check box, if it is selected.

5. To specify the location for the drawing, choose the Browse button available on the right of the
Location edit box; the Browse For Folder dialog box is displayed. By default, the CADCIM
project is selected. Choose the OK button; the location of the drawing is automatically
displayed in the Location edit box.
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Create Mew Drawing @
Drawing File
Mame:
Template: Browse...
|| For Reference Only

Location: C:\Users\CADCIM\Documents\AcadE 2017"AeData'proj\ CADCIM

C:MUsers\CADCIM'Documents' AcadE 201 7\AeData proj\CADCIM

Description 1: -
Description 2: -
Description 3: -

|EC - Style Designators
Project Code:

Installation Code:

’ Drawing... ] [ Project... ]

Location Code:

’ Drawing... ] [ Project... ]

Sheet Values
Sheet: Section: -

Drawing: Sub-Section: -

OK - Properties... 0K [ Cancel ] [ Help ]

Figure 2-60 The Create New Drawing dialog box

6. Enter 3 Phase Motors in the Description 1 edit box.

7. Enter Motor Control Circuit in the Description 2 edit box and enter 01 in the Drawing
edit box in the Sheet Values area.

8. Choose the OK button from the Create New Drawing dialog box; you will notice that
the drawing that you created gets added to the active project. To view the drawing that
you created, double-click on the project name in the Project Manager; the drawing list is
displayed and the drawing C02_tut01.dwg appears in bold text in the Project Manager.
In this case, the active project is CADCIM; and therefore, the drawing gets added to this
project. Click on the drawing; the details and the preview of the drawing are displayed in
the Project Manager, as shown in Figures 2-61 and 2-62.
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Preview EE -

Details I
Status: Locked by CADCIM -
(CADCIM-PC) r
Sheet:

Description: 3 Phase Motors
Description: Motor Control
Circuit

Description:

m

File Name: C02_tut(l.dwg

Location: C:\Users\CADCIM
"Documents\AcadE 2017
\AeDatahprof\CADCIM

-

Figure 2-61 The Details rollout displaying — Figure 2-62 The Preview area displaying
the description of CO2_tut01.dwg the preview of CO2_tut01.dwg

Tutorial 2

In this tutorial, you will add and remove drawings from the CADCIM project and replace the
drawings of the POINT2POINT project with the CADCIM project that you created in Tutorial
1 of this chapter. (Expected time: 15 min)

The following steps are required to complete this tutorial:

a. Add drawings from the existing project.
b. Remove the drawing.
c.  Replace the drawing.

Adding Drawings from the Existing Project
1. If the Project Manager is not displayed, choose the Manager tool from the Project Tools
panel of the Project tab; the Project Manager is displayed.

2. lo add drawings to the CADCIM project, right-click on it; a shortcut menu is displayed.
Choose the Add Drawings option from the shortcut menu; the Select Files to Add dialog box
is displayed.

3. Select the Proj folder from the Look in drop-down list; a list of all the projects saved in this
folder is displayed. Next, double-click on the NFPAdemo folder from the Select Files to
Add dialog box; the drawings present in this folder are displayed.

4. Press SHIFT/CTRL and select the DEMOO1, DEMO02, DEMOQ03, DEMO04, and DEMO05
drawings.

5. Next, choose the Add button; the Apply Project Defaults to Drawing Settings message box
is displayed.
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6. Choosethe Yesbutton from thismessagebox;

Removing the Drawing
1.

EERS-EESD O
|capcIm [
Projects -
== CADCIM -
C02_tut0l.dwg I
DEMO0LDWE
DEMO02.DWG

the selected drawings are added to the
CADCIM project, as shown in Figure 2-63.

Projects

To remove the DEMOO01.dwg drawing from
the project, right-click on itand then choose I ——
the Remove option from the shortcut A DEMODA DWG
menu displayed; the Project Manager - {8 DEMOUS.DWG
Remove Files message box is displayed. 5 EXTRA LIBRARY DEMO |
Choose the Yes button in this message box; L NERARENO =

the DEMOO1.dwg drawing is removed from  Figure 2-63 The Project Manager displaying the
the drawing list, see Figure 2-64. CADCIM project with the drawings added to it

m

Location Yiew

Replacing the Drawing

1.

To replace the DEMO02.dwg drawing of the CADCIM project with the Connector.dwg of
the POINT2POINT project, right-click on the DEMO02.dwg drawing; a shortcut menu is
displayed. Choose the Replace option from the shortcut menu; the Select Replacement
Drawing dialog box is displayed.

Select the Proj folder from the Look in drop-down list. Next, double-click on the Point2Point
folder; the Connectordwg drawing is displayed in the Select Replacement Drawing dialog
box.

Select the Connector.dwg drawing from this dialog box and choose the Select button; the
Apply Project Defaults to Drawing Settings message box is displayed. Next, choose the
Yes button; the DEMO02.dwg is replaced with the Connectordwg drawing in the CADCIM
project, as shown in Figure 2-65.

BERSZERSD -® i PROJECT MANAGER
|capcim [-] au:; BERS e EES -
Projects - & [caDaM -] @
=t CADCIM - b
1 C02_tut0L.dwg LD o £
W DEMO02.DW/G - =-f=| CADCIM =
4 DEMOD3.DWG = |z
1 DEMOD4.DUVG = | Connector.dwg |5
--F3 DEMO0S.DWG % 1 DEMO0Z.0WG z
- | EXTRA LIBRARY DERAQ mll & . DEMOOL.DWG =
em s
:ﬁ E::E?E;:w?m M _:'_[_}EM?G_S IZ_JW? e %

Figure 2-64 The Project Manager displaying Figure 2-65 Tﬁe P ?‘oject Manager displaying .the
the CADCIM project after removing the CADCIM project with the DEMOO2.dwg drawing
DEMOO1.dwg drawing replaced by the Connectordwg drawing
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Tutorial 3

In this tutorial, you will create a subfolder within a CADCIM project. You will also configure
the drawing list display for the CADCIM project. (Expected time: 15 min)

The following steps are required to complete this tutorial:

a. Create a subfolder.
b. Configure the drawing list display.

Creating a Subfolder

In this section, you will create a subfolder in the CADCIM project that is created in Tutorial 1.

1. Make sure that the CADCIM project is activated E@ S EES - @
in the Project Manager. Next, right-click on it; CADCIM g
a shortcut menu is displayed. Projects -
= CADCIM -
2. Choose the Add Subfolder option from the W Connector.dwg I
shortcut menu; a subfolder with the name NEW ¥Ry DEMO03.0WG
FOLDER is created within the CADCIM project. B DEMO04DWE gl | 2
Rename it as TUTORIALS. E DEMCINS. DMWY G %
=7 TUTORIALS BNk
3. Drag and drop the C02_tut01.dwg drawing 3 C02_tut0l.dwy 5
created in Tutorial 1 on the TUTORIALS e EXTRA LIBRARY DEMO
subfolder; the CO2_tut01.dwg drawing is moved to 1 teal MEDANERACY =

the TUTORIALS subfold fer to Fi -66.
¢ TUTO § sublolder, refer to Figure 2-66 Figure 2-66 The C0O2_tut01.dwg moved

Note to the TUTORIALS subfolder

1. In AutoCAD electrical, all projects and its subfolders names are displayed in wpper case.

2. You can collapse the CADCIM project by right-clicking on its name and choosing the Collapse
All option from the shortcut menu displayed.

COnflgurmg the Drawing List Display
Choose the Drawing List Display Configuration button from the Project Manager; the
Drawing List Display Configuration dialog box is displayed. You will notice that only the
file name is displayed in the Current Display Order area.

2. Select Drawing Number(%D) from the Display Options area and then choose the >>
button; Drawing Number(%D) is moved to the Current Display Order area.

3. Similarly, select Drawing Description 1 from the Display Options area and choose the >>
button; Drawing Description 1 is moved to the Current Display Order area. Next, choose
the OK button to close the Drawing List Display Configuration dialog box.
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Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. Which of the following buttons in the Project Manager is used to execute the pending

updates?
(a) New Project (b) Refresh
(c) Project Task List (d) Surfer
2. The option is used to plot all drawings of a project or a specified group of
drawings.
3. The option is used to create the copies of an existing project including all

drawing and project related files.

4. The dialog box is used to edit the properties of a drawing.
5. Choose the button to preview a selected drawing.
6. You can add up to lines of description per page for each drawing in a project.

7. A project file is an ASCII text file. (T/F)

8. The Project Manager is used to manage the project files only. (1/F)

9. A project file always consists of drawings placed in a single directory. (1/F)

10. You can switch between sequential drawings in an active project. (1/F)
Review Questions

Answer the following questions:

1. Which of the following buttons is used to change the appearance of a drawing list displayed
in the Project Manager?

(a) Plot Project (b) Project Task List
(c) Move Up (d) Drawing List Display Configuration

2. Which of the following options is used to add existing drawing(s) to a project?

(a) Descriptions (b) Add Active Drawing
(c) Add Drawings (d) Title Block Update
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3. The Remove Drawings option is used both for removing and deleting a drawing file. (1/F)
4. You can close only the non-active projects. (1/F)

5. Projects can be closed by using the Project selection drop-down list. (1/F)

EXERCISES

Exercise 1
Create a new project with the project name NEW_PROJECT and add appropriate description to
it. (Expected time: 10 min)

Note
1t is recommended to save all exercises of the forthcoming chapters in the NEW_PROJECT project.

Exercise 2

Create a new drawing with the name C02_exer02.dwg in the project created in Exercise 1 and
add appropriate description to it. (Expected time: 10 min)

Exercise 3

Using the Copy button, create a new project with the name COPY_PROJECT containing the
drawings and settings of any existing project. (Expected time: 10 min)

Answers to Self-Evaluation Test
1. C, 2. Plot Project, 3. Copy Project, 4. Drawing Properties, 5. Preview, 6. three, 7. T, 8. I,
9.F 10.T



